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Installation
Requirements

URL Manager Pro 3.3 requires Mac OS X 10.2 or higher. On Mac OS X 10.1 you can use URL Manager
Pro 3.1.1. URL Manager Pro 2.8 is still available for Mac OS 8 users. The bundle size of URL Manager
Pro 3.3 is around 8 MB, including this user manual and localizations for English, Japanese, German,
French, Spanish and Italian, which are all included in the default package.

Installing

Installation is very easy, just move URL Manager Pro into the Applications folder. To start using URL
Manager Pro, simply double-click the application icon.

Optional: You may want to install the Add Bookmark Contextual Menu Item plug-in. The Add Bookmark
plug-in can be installed using the URLSs tab of the Preferences Window of URL Manager Pro. The plug-in
will then be copied to:

~/Library/Contextual Menu Items/

Where ~ is the customary Unix shorthand to indicate the user's home directory. For more information, go to
the Add Bookmark Web page or the Contextual Menu Item section in the Special Features chapter.

The Bookmark Menu Extra

While URL Manager Pro is running, it automatically adds the Bookmark Menu Extra to the menu bar. With
the Bookmark Menu Extra you have access to your bookmarks from within any application, including your
web browser. The Bookmark Menu Extra is located in the right part of your menu bar (see below).
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- The Bookmark Menu Extra -

Using the Bookmark Menu Extra, you can add bookmarks, launch bookmarks, and easily open bookmark
files and switch between your bookmark files. With URL Manager Pro you store your bookmarks in
bookmark files that you can create and manage and have control over. You can organize and create several
bookmark files and have easy access to them via the Cabinet feature of URL Manager Pro.
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Installing Shared Menus (optional)

We prefer you use the Bookmark Menu Extra, but you may want to use the Shared Menus feature instead.
We prefer the Bookmark Menu Extra, because it is not likely to interfere with other programs and does not
involve installation of a separate component of software. The Shared Bookmark Menu is appended to right
of the Help menu of your web browser. As such, the Shared Bookmark Menu appears more in the middle
of your menu bar than the Bookmark Menu Extra. The chapter ‘Bookmark Menu’ of this manual explains
the difference between the Shared Menus and the Bookmark Menu Extra. In the screen shot below, you can
see the URL Manager Pro Shared Icon Menu and the Shared Bookmark Menu (also an icon menu).
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— Shared Menus in Safari —

You can install Shared Menus using the Menu Extra tab of the Preferences Window. URL Manager Pro
will then install the Shared Menus Component in:

~/Library/Components/

Where ~ is the customary Unix shorthand to indicate the user's home directory. If the folder Components
does not yet exist, it will be created. (The picture below shows the file path of the Shared Menus
Component for a user with user name alco).
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— The file path of the Shared Menus Component —

Many applications, like Eudora and Microsoft Internet Explorer support the Shared Menus Protocol, but
some do not, like Safari. You can make all applications Shared Menus aware, by installing my Shared
Menus Enhancer. The Shared Menus Enhancer (SME) is an APE module and can be downloaded from:

Shared Menus Enhancer web page: <http://www.url-manager.com/sme.html>

To remove the Shared Menus Component, you can again use the Menu Extra tab of the Preferences
Window or you can remove it manually. To take effect, you need to quit and launch your web browser.
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Where to store your bookmark files

We strongly advise you to store your bookmark files in a folder named Bookmarks in your Documents

folder. The Documents folder already exists and was created by the Mac OS. Please create a Bookmarks
folder in your Documents folder.

Furthermore, we suggest you create two folders in your Bookmarks folder. One named Cabinet and one
named Startup Items. Put all your bookmark files in the Cabinet folder. Then make an alias of your primary
bookmark file and put the alias in the Startup Items folder.

In the picture below, you can see how your hierarchy of bookmark files should look (in the case for a user
with user name alco):
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— The paths of the Cabinet and Startup Items folders —

The URL Manager Pro folder includes a bookmark file called Sample. Sample contains a small collection
of bookmarks that we refer to in the tutorial Getting Started. These bookmarks will also be useful to help
you get started exploring the Web with URL Manager Pro.

Please move the file Sample to the Startup Items folder as defined in the above hierarchy when you want to
follow the Getting Started tutorial.
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User Manual

The User Manual is part of the URL Manager Pro package. You can choose the following commands from
the Help menu in URL Manager Pro:

¢ URL Manager Pro Help
¢  Shared Menus Help

¢ Keyboard Shortcuts

¢ User Manual

URL Manager Pro is an application

URL Manager Pro works with popular Internet applications, including Safari, Microsoft Internet Explorer,
OmniWeb, Firefox, Camino, Mozilla, Netscape, iCab and Opera. Because URL Manager Pro is not an
extension to your Internet applications, but a standalone program, it does not consume memory when you
are not using it.

URL Manager Pro is a Mach-O bundled application (Mac OS X native) and is localized in English,
Japanese, German, French, Italian and Spanish.
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Getting Started

Introduction

The Getting Started section contains a tutorial to help you get up to speed quickly using URL Manager Pro.
In this tutorial, you will be introduced to the following topics:

¢ Opening Web Pages
¢  Adding bookmarks to URL Manager Pro
¢ Organizing your bookmarks

The Sample file

To follow the tutorial, please locate the bookmark file Sample. You can find it in the URL Manager Pro
folder. Sample contains a collection of bookmarks.

Note: Bookmarks contain Universal Resource Locators (URLs), the format in which Internet addresses are
stored. A URL is represented in URL Manager Pro as a bookmark.

By exploring the sample collection of bookmarks, you will get a sense of the power and versatility of URL
Manager Pro. Naturally, as soon as you familiarize yourself with the way the program works, you will want
to start your own collection of bookmarks.

Opening Web Pages

You can open Web pages from bookmarks stored in URL Manager Pro in one of four ways. The first way
is by opening a bookmark from within URL Manager Pro. The second way is by using URL Manager Pro's
Bookmark Menu Extra or Shared Bookmark Menu feature for opening a Web page from within your web
browser. The third way is through the popup menu of URL Manager Pro’s icon in the Dock. A fourth way
is by using Drag & Drop. Each of these four approaches has advantages, which we describe below.

Opening a bookmark from URL Manager Pro

A good place to start learning how to use URL Manager Pro is by going to the URL Manager Pro Home
Page. URL Manager Pro is updated on a regular basis, and it is possible that there is a newer version
available than the one you have, particularly if you obtained your copy on CD-ROM. It is always a good
idea to use the latest version of URL Manager Pro.

Open the Sample file and look at the Tutorial folder, the top folder in the Sample document window. You
will find four bookmarks. Double-click the first bookmark, called URL Manager Pro's Home Page.

] Name
v Tutorial
-.fD URL Manager Pro's Home Page
fD Purchase Online!
7 Contact the author

_6-
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If your Web browser isn't running, URL Manager Pro will launch it. If your browser is running, URL
Manager Pro will try to open this Web page in it. If you are not connected to the Internet, your Web
browser will alert you that it cannot make a network connection. In this case, you should start your PPP
dialer or whatever other programs you use to connect to the Internet.

If you are connected to the Internet, your Web browser should load the URL Manager Pro Home Page. It
may take several seconds to load completely. Once the URL Manager Pro Home Page is loaded, take a
moment to view the contents of this page. You'll find it offers links to many useful things, such as the latest
version of URL Manager Pro in various languages, documentation, support addresses, and the like.

To find out which version of URL Manager Pro you have, go to the URL Manager Pro menu and select
About URL Manager Pro... You will see a window that displays the version number.

If a later (that is, a higher-numbered) version of URL Manager Pro is available on our Web site, click on a
download link and you will be prompted to download it to your computer.

Once the file transfer has been completed, exit URL Manager Pro, open the file you downloaded, and
install the newer version of URL Manager Pro by replacing the application in the URL Manager Pro folder
with the newer version. Restart URL Manager Pro. You are now up-to-date!

We recommend you check the URL Manager Pro Web site regularly for new versions and additional useful
information about URL Manager Pro and our related products.

Opening Web pages from within URL Manager Pro is a good way to start surfing the Web. However, if
you have already opened your Web browser and have been surfing for some time, you may find it more
convenient to open a Web page from within your browser (provided you stored its bookmark in URL
Manager Pro). You will learn how to do that in the next section.

Opening a Web page from within your browser
URL Manager Pro can give you access to its bookmarks from within your browser in three different ways:
the Bookmark Menu Extra, the Bookmark Shared Menu and the Dock Menu.

The Bookmark Menu Extra shows all your bookmarks and is located in the Menu Extras or ‘menulets’ area
of the menu bar in Mac OS X. The Bookmark Menu Extra’s icon is the URL Manager Pro document icon
(left of “Wed’ in the picture below).
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- The document icon menu at the left is the Bookmark Menu Extra -

If you click on the document icon menu, you will see that it lists all the folders and bookmarks in the
current open bookmark file. It also has a command to bookmark the current Web page.

The Bookmark Menu Extra is the preferred way of accessing and adding your bookmarks.

The Dock Menu appears when you Control-Click on the URL Manager Pro icon in the Mac OS X Dock.
Again you will see that the submenu Sample with the URL Manager Pro document icon shows all the
folders and bookmarks in the current open bookmark file (Sample in this example).
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- Dock Menu -

Shared Menus are new menus appended to the menu bar of your Web browser and other Internet
applications. Called the URL Manager Pro Shared Icon Menu and URL Manager Pro Shared
Bookmark Menu, they contain a number of useful URL Manager Pro commands, which allow you to
control URL Manager Pro and the bookmarks you have saved in it from within your browser.

Below you see Safari's menu bar with URL Manager Pro's Shared Icon Menu and Sample Shared
Bookmark Menu installed. The menu Sample, right next to URL Manager Pro's Shared Icon Menu,
displays all bookmarks in your current open URL Manager Pro bookmark document. The name of the
menu is the name of the document, in this case Sample. (It is also possible to have a document icon
displayed instead of the document name. Choose Preferences from the URL Manager Pro Shared Icon
Menu and select the Appearance tab).
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- The Shared Menus shown at work in Safari -
If you go to the Sample menu, you will see that it shows all the folders and subfolders in the Sample file.

If, for example, you select URL Manager Pro's Home Page from the Tutorial submenu, your Web
browser will open this page, provided you are connected to the Internet. Once you get used to using the
Shared Menus, you will find that it is a powerful feature of URL Manager Pro. The URL Manager Pro

-8-
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Shared Icon Menu and the Shared Bookmark Menu are explained in this user manual, but more specific
information is also available in the Shared Menus Help book.

Note: We prefer you use the Bookmark Menu Extra or the Dock Menu. Shared Menus are still fully
supported, however, mainly to support URL Manager Pro users coming from Mac OS 9.

Note: If you double-click the Contact the Author bookmark, your email program will launch. This is
because it is a different type of bookmark. It is a bookmark with the mailto: protocol. This feature of URL
Manager Pro is described in more detail later.

Open a Web page using Drag & Drop

Drag & Drop is a powerful feature of the Mac operating system. It allows you to drag icons and other
objects from one program to another. This is very useful for opening Web pages for which you’ve stored
bookmarks in URL Manager Pro. To open a Web page using Drag & Drop, you will need to make both
your browser and the URL Manager Pro windows visible. On a large monitor, this shouldn't be difficult; on
a PowerBook, one window may have to slightly overlap the other.

Activate the URL Manager Pro bookmark window by clicking on its window title bar. Open a folder by
double-clicking on it or clicking the disclosure triangle. For example, open the Magazines folder.

Select, for example, the MacWorld bookmark icon.
Now, press and hold the mouse button.

While you are doing this, move the cursor over to the exposed part of your browser window —you will see
an outline of the icon as you drag it. This is to let you know that Drag & Drop is functioning.

When your mouse cursor is over the browser window, release the mouse button. You have now "dropped"
this icon in your browser. Your browser will open the MacWorld home page, provided you have an active
Internet connection.

You can explore the other bookmarks in the Sample document at your leisure, either by opening them from
within URL Manager Pro or by means of Drag & Drop. We have supplied a collection that we think may
be of interest to Mac users. However, you will probably want to start developing a collection of your own
URLSs right away. You will learn how to add URLs to URL Manager Pro in the next section.

Adding bookmarks to URL Manager Pro

You can add bookmarks to URL Manager Pro in four different ways. 1) Add bookmarks directly within the
URL Manager Pro program. 2) Use the Bookmark Menu Extra, the URL Manager Pro Shared Icon Menu
or Dock Menu. 3) Use Drag & Drop. 4) Import the bookmarks file from your Web browser. Each of these
four approaches has advantages and is described below.

Adding bookmarks directly in URL Manager Pro
If URL Manager Pro isn't already running, open the URL Manager Pro folder and click on the URL
Manager Pro icon to start the program.

As before, you will be presented with the default URL Manager Pro document called Sample.
Let's say you would like to create a bookmark for ‘The Wall Street Journal’.

Select the bookmark "Contact the author".
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Go to the Bookmark menu.
Select the command New Bookmark.

This will create a blank bookmark icon in the Sample document called Untitled. Note that the new
bookmark appears after the selection.

] Mame URL
L 4 Tutorial
fD UEL Manager Pro's Home Page @[ http:f e
fD Purchase Online! http:f for
=7 Contact the author @ mailto:su
[#] [untitled http:/ f

- Creating a new untitled bookmark -

You’ll see that the label field next to the icon is highlighted —this is URL Manager Pro's way of prompting
you to give it a name right away.

Type in: The Wall Street Journal.
Press Tab.

Now the URL field is highlighted. For the time being, ignore the string of letters http:// in this field. This is
part of the Internet's URL addressing scheme. It indicates that the address is a Web page. (This is the URL
Manager Pro default.)

Click the mouse cursor to the right of http:// and type: www.ws j . com
Press Enter when you are done. The new icon is now called "The Wall Street Journal".

Make sure that you typed the URL correctly and that there are no spaces. If there are any spaces, URL
Manager Pro will not be able to open the page.

Now double-click on the new The Wall Street Journal icon. Your Web browser will open The Wall Street
Journal Web page, provided you have an active Internet connection.

You will find this technique for entering a bookmark directly in URL Manager Pro useful for adding a
bookmark you find listed in a magazine or newspaper or another source other than your computer. For a
bookmark you discover when surfing the Internet, there is a better way of adding it to URL Manager Pro.

At this point, now that you have started customizing your collection of bookmarks, you may want to give it
a more meaningful name. Let's rename the Sample document.

Go to the File menu.

Select Save As... You will be prompted to give it another name (the name of the current document, Sample,
is listed as default).

-10 -
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Type in a suitable name, such as: M\y Bookmarks

The Save As window will look something like this:

Save As: My Bookmarks

Where: | Bookmarks T! m

Cancel € Save 3

- The Save As Window -

Use the popup menu next to the Where: label. Select Documents from that popup menu to make the
Documents directory the current directory.

Use the downward pointing triangle button to expand the window.

Click the New Folder button. Enter the folder name Bookmarks. Now save your new file in this new
folder.

Sample has now been renamed My Bookmarks and is saved in the folder ~/Documents/Bookmarks/ on
your hard disk.

Tip: To have a bookmark file open automatically each time you launch URL Manager Pro, open
Preferences and use the button Select Startup Bookmark File...

Note: To have multiple bookmark files open automatically each time you launch URL Manager Pro, put
these files into a folder named Startup Items in the ~/Documents/Bookmarks/ folder. In addition, you may
want to drag the Sample document out of Startup Items so that it will not be loaded at startup. Put it in the
Cabinet folder instead. You can easily open documents in the Cabinet folder from within URL Manager
Pro via the Quick Open menu command under the File menu. You can also use the Cabinet toolbar item
for quick access to your bookmark files (see below).

-11 -
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- The Cabinet toolbar item shows the bookmark files in the Cabinet -

Furthermore, documents in the Cabinet folder are listed in the Cabinet submenu of the Bookmark Menu
Extra, URL Manager Pro Shared Icon Menu and the Dock Menu. This means you can open your bookmark
files right from within your browser!

Below you can see the preferred hierarchy of storing your bookmark documents.

v 1t alco
¥ | Documents
v Bookmarks
b Cabinet

B |2 Startup ltems
- The file paths of the Cabinet and Startup Items folders visually shown -

Note: You may use aliases for the Startup Items and Cabinet folders, and the bookmarks files may also be
aliases. The Cabinet and Startup Items folders are more fully explained in the Special Features section of
the User’s Manual Reference section.

Adding Bookmarks to URL Manager Pro from within your browser
First, switch to your browser.

Let's say you are on a Web page that you would like to save as a bookmark in URL Manager Pro—for
example: http://www.washingtonpost.com. (For the purposes of this tutorial, open the home
page of this well-known newspaper in your Web browser.)

If you use the Bookmark Menu Extra, click the document icon menu and select the command Add
Bookmark.... If you use Shared Menus, go to the Sample or My Bookmarks Shared Menu and select the
first command, Add Bookmark.... If you use the Dock Menu, Control-Click the URL Manager Pro icon in
the Dock and select the command Add Bookmark....

The Add Bookmark Window will appear (see next page). By default, the title of the Web page is
displayed as the name of the bookmark, but you can enter any text you wish. In this case, the default is
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